Working with your video clips in Windows
Movie Maker 2
The elements of Windows Movie Maker: Collections, clips, projects,
and movies

Understanding collections and clips
Collections are libraries that contain the different video, audio, and pictures that you've imported into
or captured in Windows Movie Maker 2. You can use and reuse items from the collections for the
movies you create. When you import the digital media files into Windows Movie Maker, the different
video, audio, and pictures appear as clips within one or more collection folders in Windows Movie
Maker.
To import existing digital media files
1.

On the File menu, click Import into Collections.

2.

In File name, enter the path and name of the file you want to import, and then click Import.

3.

(Optional) If you want the video files to be separated into smaller clips, select the Create clips
for video files check box.
A new collection folder is created for each video file you import into Windows Movie Maker. Any
audio clips or still images appear in the original collection that was selected when you imported
the audio and still images.
Note: You can import several files at once. For consecutive files, click the first file in the list, press
and hold down the SHIFT key, and then click the last file in the list. For files that are not
consecutive, press and hold down the CTRL key, and then click each file that you want to import.

The following figures show how source video files, audio files, and photos appear in Windows Explorer
and how they appear as clips in different collection folders after the individual files are imported in
Windows Movie Maker.

Video files in Windows Explorer and Windows Movie Maker.

Audio files in Windows Explorer and Windows Movie Maker.

Understanding projects and source files
After you import audio, video, or pictures into Windows Movie Maker, you can add the individual clips
in the different collection folders to the storyboard/timeline. The following figures show clips as they
appear in the storyboard and timeline views respectively for the same project.

Video clips in storyboard view.

Video and audio clips in storyboard view.

Video and audio clips in timeline view.

The video, audio, and image clips in Windows Movie Maker projects are only references to the files
that you've captured or imported into Windows Movie Maker. When you edit video or audio in a
collection or on the storyboard/timeline in Windows Movie Maker, you do not change the original
source video or audio file. Editing the clips on the storyboard/timeline or in a collection only
determines how and when the audio, video, and still images (as well as any titles, video transitions, or
video effects) are displayed in that particular project.
All content on the storyboard/timeline — including audio, video, still images, and video transitions,
video effects, or titles — becomes a project. Ultimately, a Windows Movie Maker project file (which
has a .mswmm file name extension) is simply a file that contains information about what content is
used in the project, as well as the timing information about how and when to display the contents on
the storyboard/timeline in the final saved movie. It does not actually contain your source files. If you
save the project, you can then later open it in Windows Movie Maker and make more edits at another
time.
To save a project
1.

On the File menu, click Save Project.

2.

In the File name box, type the file name, and then click Save.
The resulting Windows Movie Maker project file is stored on your computer.

Important: Since your Windows Movie Maker project file does not contain a copy of the
source files that are used in the project, if you want to move a Windows Movie Maker project file
and edit it on another computer, you also need to copy all of the source content to that computer
or make sure that the computer has access to the location where the source files are stored.

Saving your project as a movie
After you've saved a project, you can then save the project as a movie file, such as into a .wmv
or .avi file, by using the Save Movie Wizard. When you do this, all of the files on the
storyboard/timeline are encoded into a single digital media video file. You can then share this video
file with others, and they can watch and enjoy it in a media player, such as Windows Media Player.
To save a movie
1.

On the File menu, click Save Movie File.

2.

In the Enter a file name for your saved movie box, type a name for your movie.

3.

In the Choose a place to save your movie box, do one of the following:

•
•
•

Choose the path and folder name from the dropdown list of available places.
Click Browse to choose a new place that's not already in the dropdown list.
To create a new folder, click Make New Folder in the Browse For File dialog box, and then
type a name for the new folder.

4.

On the Movie Setting page, do one of the following:

•

To use the default movie setting, click Best quality for playback on my computer
(recommended).
The specific setting details, such as the file type, bit rate, display size, aspect ratio, and frames
per second displayed in the video, are shown in Setting details.

•

To use a different movie setting, click Show more choices, and then choose another movie
setting from the list.

5.

If you want to watch your movie after completing the wizard, select the Play movie when I

click Finish check box.
6.

After the movie is saved, click Finish.

The resulting movie is saved on your computer.

You or your audience can then play the movie in a media player, such as Windows Media Player.
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Organizing your collections
By organizing your collections, you can quickly find the content you want to use and reuse in your
movies. This can help reduce the time it takes you to create and edit your Windows Movie Maker
projects. For example, you might choose to create a new collections folder that contains only your
favorite video, audio, or still image clips.
To do this, create a new collection called Favorites, split or combine video clips in the collection, copy
clips into the Favorites collection, and then add some or all of those clips to the storyboard/timeline
for the project you're working on at that time. And remember, collections always appear in Windows
Movie Maker. Therefore, you can reuse the clips in your Favorites collection to create many different
movies simply by arranging the clips in a different order on the storyboard/timeline, as well as by
adding titles, video effects, or video transitions in different ways at different times to create different
movies from the same video and audio content.
To preview a clip
1.

In the Contents pane, click the clip you want to preview.

2.

On the monitor, click the Play button to preview the video or audio clip.

To create a new collection
1.

In the Collections pane, click the Collections folder.

2.

On the Tools menu, click New Collection Folder.

3.

Type a name for the new collection.

To split a video or audio clip
1.

In the Contents pane, click the video or audio clip you want to split.

2.

Under the monitor, move the slider to where you want to split the clip.

3.

Click the Split button on the monitor.

The resulting video clips now appear in the Contents pane.

Note: To position the slider precisely, you can drag the slider to a point before the place where
you want to split the clip, click the Play button, and then click the Stop button at the exact point
where you want the split.
To combine a split audio or video clip
1.

In the Contents pane, hold down the CTRL key, and then select the consecutive clips you want to
combine.
Note: To select consecutive clips, click the first clip, press and hold down the SHIFT key, and then
click the last clip. To select one clip at a time, press and hold down the CTRL key, and then click
each clip that you want to combine.

2.

On the Clip menu, click Combine.

The resulting video clip now appears in the Contents pane.

Note: You can also perform this entire procedure on the storyboard/timeline.
To copy a clip in a collection
1.

In the Contents pane, click the clip or clips that you want to copy.

2.

On the Edit menu, click Copy.

3.

In the Collections pane, click the collection you want to copy the clips to, and then click the
Contents pane.

4.

On the Edit menu, click Paste.

Create and trim video clips
When you download video from your camera to your computer, Windows Movie Maker splits your
video (which might be a full hour long) into shorter clips that are easier to work with, and then adds
the clips to a collection. Each time you stopped or paused recording with your video camera, Movie
Maker created a separate clip.
If you notice that Movie Maker did not break your video into clips, you might have cleared the Create
clips for video files option, which is selected by default. Follow the steps in Create video clips to
divide your movie into smaller clips.
Once you have divided your video into clips, you can immediately drag the clips from the collection to
your storyboard to create a movie. Then you should trim the video clips to show only the most
important moments. Follow the steps in Trim video clips to learn how to shorten clips on your
storyboard.

Create video clips
Clips are automatically created if you select the Create clips for video files check box when you
import a video file into Movie Maker. If the check box is not selected, the video is imported as a single
continuous clip, rather than as a series of shorter clips. You can use the Movie Maker clip detection
feature to divide a video file into smaller, more manageable clips.
To import a video file that you have already saved to your computer and automatically
create short clips
1.

Under Capture Video, click Import Video.

2.

On the Import File dialog box, select the Create clips for video files check box (it is selected
by default). Click your video file, and then click Import.

3.

Movie Maker creates clips from your video file and adds them to a new collection.
If you downloaded a video from your camera but chose not to break it into clips, it’s not too late
to make clips. In the Movie Maker Collection pane, rightclick the video. Then click Create Clips.

Now you can drag the clips from the collection to your storyboard to create your movie.

Trim video clips
You can trim the beginnings and ends of clips. In fact, you can trim clips down to just a few seconds
each. You can choose to either trim clips in your collection or trim clips on your storyboard. You
should trim clips in your collection if you plan to use the shortened clip in other movies.
If you don’t want to change the clips in your collection, you can trim them while they are on your
storyboard.
To trim video clips
1.

Drag clips from your collection to the storyboard at the bottom of the window.

2.

Select the clip you want to trim. Then click the Play button on the Preview Monitor.

3.

Let the clip play until it gets to the point where you want to trim it. Then click the Split Clip
button on the Preview Monitor. This cuts your clip into two separate clips at the current point in
the video and adds the new clips to your storyboard.
Note: If you plan to use transitions, leave an extra second at the beginning and end of each clip
to allow the clips to overlap.

4.

Delete the portion of the clip ou no longer need by rightclicking it and then clicking Delete.

Repeat this process for each clip. You can split clips several times to use more than one moment
from a clip. If you do a lot of editing, you might find it easier to use the timeline view, which
shows you how long each clip will play. To use the timeline view, click the Show Timeline
button.

Add transitions and special effects
Windows Movie Maker includes about 60 transitions and 28 special effects you can easily use to add
professional touches and visual interest to your movies.
Transitions are how one scene switches to the next. Rather than simply ending one scene and beginning
the next, you can use Movie Maker transitions to insert fades, flips, dissolves, and other dramatic shifts
between scenes.
Special effects change the appearance of a video clip by rotating it, slowing it down or speeding it up, or
making it appear like old film footage. Like transitions, you can easily add special effects to your movie by
dragging the relevant special effect icon onto your movie timeline.

How to add a transition
To add a transition between two movie clips
1.

Download video from your camera to your computer, and add clips from your collection to your
storyboard.

2.

In the Movie Tasks pane, under Edit Movie, click View video transitions.

3.

Preview transitions by doubleclicking them and watching the Preview Monitor. Once you've found
a transition you like, drag it from the Video Transitions pane, under Edit Movie pane to the box
between two of your clips. This inserts the transition between the two clips.

4.

In the Preview Monitor, click the Video Transitions pane, under Play button to watch your
transition in action. If you don't like it, just return to the previous step to replace it with a
different transition.

If you decide not to use any transition, rightclick it on the storyboard, and click Delete.

Transitions cause your video clips to overlap by about one second, which means you won't see all
of the first or last second of your clip. So, when you're filming, it's good to start the camera a few
seconds before the action starts, and to keep filming for a couple of seconds afterward so that
you have time to transition between scenes. This also helps you get a steadier shot. If you don't
need the extra time in a clip, you can trim it from your clip in Movie Maker.

How to add a special effect
You can use special effects to change how your clips play in several different ways:

•
•
•
•

Speed up a clip using Speed Up, Double, or slow down a clip using Slow Down, Half.
Zoom in using Ease In, or zoom out using Ease Out.
Make a clip appear older by using Sepia Tone, Film Age, or Grayscale.
Rotate a clip using one of the Rotate effects (perfect if someone accidentally holds the camera
sideways).

•
•

Fade in using one of the Fade In effects, or fade out using one of the Fade Out effects.
Fix exposure problems using Brightness, Decrease or Brightness, Increase.

To add a special effect
1.

In the Movie Tasks pane, under Edit Movie click View video effects.

2.

Preview effects by doubleclicking them and watching the Preview Monitor. Once you’ve found an
effect you like, drag it from the Video Effects pane to one of your clips. This adds the effect to
the clip, which you can see by looking at the star in the lowerleft corner of the clip.

3.

In the Preview Monitor, click the Play button to watch your effect in action.

You can add more than one effect to a clip. For example, if you want to both brighten a clip and
add a zoom effect, you can add Ease In and Brightness, Increase. You can also add a single
effect multiple times to increase the effect. For example, add multiple Brightness, Increase
effects to brighten a scene even more, or add two Speed Up Double effects to quadruple the
speed of a clip.
If you don't like the effect, rightclick the star icon in the lowerleft corner of the clip, and click
Delete Effects.

Add titles and credits
By using the title and credits feature in Windows Movie Maker, you can easily create an interesting
title sequence at the beginning of your movie and provide a list of credits at the end. You can also
place titles in between scenes of the movie.
Opening titles introduce your movie to your audience and provide background information about what
they're about to watch. You can show a title on a blank background or over your first clip.

Credits at the end of your movie provide a more satisfying ending. You can show credits on a blank
background or over your last clip. In Movie Maker, credits are considered a special type of title that
can comprise many lines.

You can use titles throughout your movie to introduce scenes or describe what is happening on screen.

To add a title screen before your movie
1.

If you want to add a title before, after, or on top of a clip, click the clip on the storyboard or
timeline.

2.

In the Movie Tasks pane, under Edit Movie, click Make titles or credits.

3.

Choose the type of title you want to add.

4.

Click Change the title animation. Notice that you can choose between oneline titles, twoline
titles, and credits, which can be many lines. You can use credits any time you need to display
more than two lines of text, not just at the end of your video.

5.

On the Choose the Title Animation page, browse through the different animations and watch
them in the Preview Monitor to get an idea of what they'll look like. When you find the
animation you want to use, click Change the text font and colour.

6.

On the Select Title Font and Colour page, choose the colour and font you want to use. If
you're adding the title over a clip, use a dark font colour for bright scenes and a light font colour
for dark scenes. Then click Edit the title text.

7.

On the Enter Text for Title page, enter your text. Then click Done to add the title to your
movie.

8.

If prompted to switch to the timeline view, click OK.

9.

In the Preview Monitor, click the Play button to see how your title will look in your video.

10.

If you want to change your title (for example, to change the colour of the text to make it more
readable), rightclick the title on the Title Overlay row of the timeline, and then click Edit Title
on the shortcut menu.

Remember, you can add titles any time you want the viewer to know what you're showing or
who someone on the screen is.

Add music
To add music to your movie:
1.

In the Movie Tasks pane in Movie Maker, under Capture Video, click Import audio or music.

2.

In the Import File dialog box, click the name of the song you want to use in the background.
Then click Import. This adds your song to your collection but does not add it to your video.

3.

Drag the song from the collection to the video clip where you want the music to start playing.

4.

If prompted, click OK.

5.

Movie Maker shows your song on the timeline. If the song extends beyond the end of the movie,
drag the right edge of the song so that it ends at the same time as your movie. Otherwise, the
song will keep playing after your movie is done.

6.

Click Play in the Preview Monitor to watch your movie and listen to the background music.

7.

If the background music is too loud or too soft in comparison to the movie, rightclick the music
on your timeline, and then click Volume. If the audio and music sound good, you can skip the
next step.

8.

In the Audio Clip Volume dialog box, move the slider to the left to make the music quieter, or to

the right to make it louder. Then click OK.

Add narration
With Windows Movie Maker you can add or replace the audio with your own narration of the action, or
with music.

•

Add music. Add music to your movie. This is perfect when you want to create an atmosphere or
add some energy to your movie.

•

Add narration. Record yourself speaking over your movie.

Note: If you want background music instead of narration, you can use titles to introduce people or
describe settings.
To add narration to your movie
1.

If you have a desktop computer, connect a microphone. You will get a better quality recording if
you connect an external microphone.

2.

In Movie Maker, click the Tools menu, and then click Narrate Timeline.

3.

If prompted, click OK.

4.

On the timeline, click the clip you want to narrate. You can narrate clips one at a time, or you
can narrate the entire movie all at once. If you narrate individual clips, you can rearrange them
later and keep your narration synchronized.

5.

Speak normally into your microphone, and adjust the Input level so that the bar is about
halfway up when you are speaking.

6.

Under Narrate Timeline click Start Narration.

7.

Speak into your microphone as Movie Maker plays your movie. You can narrate your entire
movie at once or just one clip at a time. When you're done narrating, click Stop Narration.

8.

Movie Maker will save your narration as a separate file. In the Save Windows Media File dialog
box, type a name for your narration. Then click Save.

9.

Movie Maker adds your narration to your video. If you only narrated part of your video and you
want to add narration to other clips, return to step 4.

10.

Click Play in the Preview Monitor to watch your movie and listen to the narration.

11.

If the narration is too loud or too soft in comparison to the movie, rightclick the narration on
your timeline, and then click Volume. If the audio and narration sound good, you can skip the
next step.

12.

In the Audio Clip Volume dialog box, move the slider to the left to make the narration quieter,
or move it to the right to make it louder. Then click OK. Return to step 11 to listen to the
narration again, and make another adjustment if necessary.

To delete narration so that you can rerecord it, rightclick the narration on the timeline, and
then click Delete. You should also delete the narration from the collection.

Save your movie to your computer
Saving a movie that you created in Windows Movie Maker as a file on your computer will give you the
highestquality movie file. Later, you can watch the movie by doubleclicking it, which opens and
plays it in Windows Media Player. Computers will probably always support common video formats, so
saving your video to your computer is also a great way to make sure it will always be accessible.
To save your movie to your computer
1.

Open your movie in Movie Maker.

2.

In the Movie Tasks pane, under Finish Movie, click Save to my computer.

3.

The Save Movie Wizard appears. On the Save Movie File page, type a name for your movie. You
can also choose a folder to save it in by clicking the Browse button, but My Videos (the default)
is usually the best place to save your movie. Then click Next.

4.

On the Movie Setting page, click Next to accept the default setting of Best quality for
playback on my computer.

5.

Movie Maker saves your movie, which might take several minutes. On the Completing the Save
Movie Wizard page, click Finish. If Play movie when I click Finish was selected (it is selected
by default), the movie will automatically play in Windows Media Player.

